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Seminar Type:  Microsoft Products, Sales & Marketing 

 
Seminar Level:   
Intermediate Level: An Intermediate level class takes the concepts originated from a basic 
level course, and adds more layers or parallel concepts. For functional courses, these classes 
will require the participant or attendee to have some basis to work from as they are learning new 
facets of the agency management system or software program.  
 

Class Description:  Building on the previous session, Introduction to TAM Formletters and 

Proposals Interface, this session describes in detail the many ways in which ASK and IF 
statements can be used to enhance the professional look of your agency's proposal, as well as 
the efficiency with which your staff is able to create the proposals. We will also discuss the math 
functions available in Word. 

 
Learning Outcomes:   

 Utilize the information in your TAM database to automatically customize your proposal 
for your client or prospect. 

 Discover how to use questions answered by the person creating the proposal to insert 
complex information into the document without further intervention. 

 Identify ways to have Word perform calculations such as totaling schedules and 
calculating taxes, without you ever reaching for the calculator. 

 Expand basic TAM/Word interface skills 

 
Assumptions:  This seminar is based on the following 

TAM Version 11.X 
Microsoft ® Word Version 2007/2010 
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Using Existing Templates 

Once you have created a formletter or proposal document that has the look and style 
you want, it is a time saver to use that as the basis for your other documents instead of 
starting with a blank document each time. Here is how you can do that. 
 

 Open up Windows Explorer and navigate to the DOC folder on your TAM drive 
o If you are copying a formletter, go to the \CFORMLET folder 
o If you are copying a proposal, go to the \PROPDOC folder 

 Find and highlight the file you wish to copy 

 Right-click and Copy (or Ctrl-C) 

 Right-click in a blank area of the window and Paste. 

 Rename the file from ―Copy of …‖ to the 8 character (max) you want for your new 
template. Make sure you keep the .RTF extension. 

 In Document Setup, create a new document with the file name you just created. 
When you click OK the copy you just created will open and you can edit it as you 
wish. 
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Advanced Utilization of ASK Variables & IF Statements 

ASK/IF Combination 

In order to use a combination of the ASK variable and IF statement, create the ASK 
variable first.  For example, in some cases you need a deposit in order to bind 
coverage.  So we ASK the question whether a deposit is needed,  then we create an IF 
statement that "reads" the answer to the question and prints different text in the letter 
depending on the answer. 
 
To create the ASK/IF combination: 

 Create the ASK statement. It will look like this: {ASK deposit "Will a deposit be 
needed to bind coverage? Answer 1 for Yes or 2 for No"}{REF deposit} 

 Place the cursor where you want the results of the IF statement to appear in the 
template. 

 Open the IF Statement builder box. 

 Put a placeholder in the ―expression‖ field in the IF statement. 

 Complete the rest of the IF statement fields as needed. 

 Click INSERT. 

 Place the cursor between the ASK and the REF parts of the ASK variable. 

 Hold down the SHIFT key and using the right arrow key on the keyboard, select 
the entire REF portion of the ASK variable (including the parentheses marks). 

 Cut (CTRL+X) the selected REF field and then place your cursor at the beginning 
of the place card you used in the ―Expression‖ portion of the IF statement. 

 Hold down the SHIFT key and using the right arrow key on the keyboard, select 
the entire place card. 

 Paste (CTRL+V) the REF into the expression portion. 
 
The IF statement would look like this: 
{IF {REF deposit} = "1" "In order to bind coverage we will need a deposit in the amount 
shown on the premium summary page." "No payment is needed to bind coverage; you 
will be billed later."} 
 
The actual answer to the question asked is never printed in the document; it is used to 
decide what other text is inserted in the document. 

Nested IF Statements 

Nesting is putting IF statements inside other IF statements.  You would want to use this 
feature if you have more than two values you are comparing.   
 
For instance: 
You only want to offer premium financing if the policy is agency bill AND the premium is 
at least $10,000.  The completed IF statement looks like this: 
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{IF <BILL.TYPE> = "A" "{IF <PREMIUM> >= 10000 "Premium financing is available. 
Please call me if you are interested in details." ""}" ""} 
 
Let's analyze that statement: 
If the bill type is agency, then the ―true‖ section will apply. The ―true‖ section for the first 
IF statement is actually the second IF statement.  So now the code will look at the 
premium amount; if it's greater than or equal to $10,000, the ―true‖ section for the 
second, or nested, IF statement will kick in, printing the sentence about premium 
financing. However, if the premium is less than $10,000, that sentence will be skipped, 
and since the ―false‖ section is empty, nothing will print. Similarly, if the bill type is not 
agency, the entire second IF statement will be skipped and again nothing will print 
because that ―false‖ section is also empty.   
 
To create this nested IF statement: 

 Create the first IF statement, testing for <BILL.TYPE> equal to ―A‖.  Put a place 
holder such as ―abc‖ or ―true‖ in the ―true‖ section and leave the ―false‖ section 
blank. 

 Click Insert. 

 Click ALT+F9 to reveal the entire coding of the IF statement, if necessary. 

 Place your cursor at the beginning of the ―true‖ section and holding down your 
shift key, use the right arrow key on the keyboard to select the placeholder text. 
Make sure you do not select the double quote marks at either end of the 
placeholder. 

 From the Add-Ins tab on the ribbon, click on the Applied icon in the Menus 
Command group, then select IF Statement. 

 Create the second ―nested‖ IF statement, testing for <PREMIUM> equal to or 
greater than ―10000‖. In the ―true‖ section, type the ―Premium financing…‖ 
wording; leave the ―false‖ section blank. 

 Click Insert. 
 
You can nest several IF statements inside of each other although Applied recommends 
nesting IF statements no more than 15 deep within a single IF statement.  
 
Some other suggested uses for Nested IF Statements: 

 Pull in signature graphics based on Producer, CSR or Operator ID.  

 Pull in agency logos based on Agency or Branch code.   

 Pull Producer direct phone numbers or email addresses based on Producer code 
into your Agency Service team template.  
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Using Tables with Replicate Command 

Use tables to organize information and even create interesting page layouts with side-
by-side columns of text and graphics. You can create a new blank table with the Table 
button under the Insert tab on the Ribbon and fill in the empty cells, or you can convert 
existing paragraphs of text (separated by a character such as a tab) to a table. One of 
the best features of a table is the ability to format by column, row or cell.  Tables are a 
great replacement for tabs to align schedules in TAM.  
 
Tip:  Never create a table on the first line of a document. Always put at least one 
paragraph return before the table; otherwise, your document will not work when you use 
it at the client/prospect level. 
 
To create a table using the Replicate Command: 

 If you are at the top of your document, Return at least once. 

 Create a table with 2 rows and as many columns as you need. 

 Click once anywhere in the table, right-click and select Table Properties, Options 
and uncheck the box ―Automatically resize to fit contents‖. 

 In the first row, type the headers for the schedule. Format as desired. 

 In the second row, insert your data fields (Applied, Data Fields) with whatever 
formatting, IF statements, etc. needed. 

 Adjust the column widths for the headers and data, keeping in mind that your 
actual data may be shorter than the field name.  For example, the year of a 
vehicle is four digits long, whereas the field name is AP.EF.MODEL_YEAR, 
which is 33 characters including all of the formatting. 

 Save the document and test it on a client. Since you haven’t put the Replicate 
commands in yet, you will only get the first item in the schedule from the app, but 
you will be able to see whether you have the formatting and column widths 
correct. If not go back to the document, adjust as necessary, and test again. It is 
a good idea to test on more than one client because different data may have 
different lengths. 

 Once you are happy with the formatting, go back into the master document and 
place the cursor directly below the table. 

 On the Applied Menu select Replicate Command. 

 Place cursor at the end of the Begin Replicate command and press the Enter key 
to create a line between the Begin and End command. 

 Take the mouse out to the left of the 2nd row containing the data fields and left-
click to select that row. 

 Right-click and select CUT (or CTRL+X). 

 Place cursor on the line between the two Begin and End commands and right-
click and choose PASTE (or CTRL-V). 

 DO NOT cut and paste either of the replicate commands as this will disable their 
functionality. 
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The end result will look similar to this: 

 
Save the document and test it. Access and edit the template to adjust as necessary. 
 
Note:  If you need to adjust column widths after you do a test merge, it is recommended 
that you delete the Replicate commands so that the table heading & data row are 
merged into one table.  Once you have made the necessary adjustments, repeat the 
steps above to re-insert the Replicate commands. 

Formatting Fields 

There are many fields available in Word in addition to the ASK and IF fields that are on 
the TAM/Word Interface menu. To see the selection that’s available, from the Insert tab, 
click on the Quick Parts icon, and select Field.  
 
A Word field begins and ends with curly brackets, { }.  Typing in the curly brackets from 
your keyboard will not create a Word field.   You need to insert them from the Insert Tab 
on the ribbon as described above.  Once you are familiar with a particular field and how 
to format it, you can save yourself time and mouse clicks by inserting a blank field using 
CRTL+F9, then typing the field command and any options between the curly brackets. 
  
Two fields that are very useful in proposal templates are the Formula field, { = }, for 
formatting numbers; and the Quote field, { QUOTE }, for formatting text. You can 
incorporate various formatting instructions within these field commands so that 
numbers, dates and text appear the way you wish, regardless of how they are entered 
in the TAM or the responses to ASK statements. 
 
As you are working with Fields and formatting them, if either the field disappears from 
the screen or you can’t see all of the formatting that you know is there, press ALT+F9 to 
reveal the field coding & formatting. 
 
For more information about fields and the options that are available, search Word Help 
for ―fields‖, ―field codes‖ or ―field switches‖. 
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Numbers 

Coverage limits in most ACORD applications in TAM are required to be entered with no 
―$‖ sign or comma separators. To display them in your proposal or letter with those 
punctuations, enter them in a Formula { = } field, like this: 

 
 
This format will fail if the data field is empty and you will get an ―Error!‖ message in the 
merged proposal.  To avoid this, we can use an IF statement to test the field first and 
force a zero into the formatting expression if the field is blank.  There is also a more 
complicated version of the number formatting which allows you to have a text 
expression print instead of $0 if the field is blank or zero. For instance, for a deductible 
you might want to print ―No Deductible‖ or ―None‖; if a limit field is blank, you might want 
it to print out as ―No Coverage‖.   
 
To include this text as part of the number formatting, enclose the ENTIRE formatting 
string, beginning before the ―$‖ sign in double quotes, separate the number format from 
the text you want to use by two ―;‖ characters AND enclose the text in single quotes.  
This more complex format, with the IF statement test, looks like this: 

 

Upper/lower case text 

Generally, you want text formatted in upper and lower case (not ALL CAPS), but data 
may be entered in applications in any number of ways.  You can use the {QUOTE} field 
with the appropriate switches to change the appearance of the field value in the merged 
document: 
 
{QUOTE "<VEHMAKE>" \* Caps} Each Word Starts With an Uppercase Letter 
{QUOTE "<VEHMAKE>" \* Upper} ALL UPPERCASE 
{QUOTE "<VEHMAKE>" \* Lower} all lowercase 

Fields that might contain numbers or text 

There are some fields in Applied that might contain numbers or text. For instance, a limit 
field might have a number in it or the word "Included".  The formatting techniques 
described above only work if the field contains data of the expected type. However, with 
yet another IF statement we can get around this. We are taking advantage of the fact 
that Word considers letters to have a higher "value" than numbers. So, we test the first 
character of the field to see if its value is less than the lower case letter "a".  If it is, we 
apply number formatting; if not, we apply text formatting. Here is an example of this field 
formatting: 
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Note:  This use of field switches will not work if the field contains mixed numbers and 
text ("$5,000 Included").  Unfortunately, there is no way to test for and correctly format 
this kind of entry. 

Dates 

By default, TAM dates will print as xx/xx/xx – for instance, 01/30/09.  You may want the 
date written out – as January 30, 2009. For this, use the { QUOTE } field: 

 
 
There are many more ways of formatting than the examples shown here. For additional 
information, go to Help in Word and search for Field Codes. 

Drawing Lines 

There are several ways to draw lines in documents, and some work better than others, 
depending on the circumstances.  One way would be to type an underscore character 
as many times as needed to create the desired line length.  To get a line completely 
across the page, type 3 underscore characters followed by Enter key. To get a double 
line, repeatedly use the = character instead of the underscore character. The problem 
with this method is when it is used as a line on a form (e.g. a company app) where the 
end user is entering information, the line will be pushed to the right instead of the text 
appearing on the line.  This is because the underscore character is a typed character.   
 
Another method for creating a line is using Underline formatting, which can be useful 
when inserting datafields.  If you set up the datafield in your formletter or proposal 
template as underlined, then the data will be underlined in the merged document at the 
client level. The underlining will be as long, or as short, as the data itself. 
 
Yet another method is to draw lines in your formletter or proposal template.  These lines 
are independent of the text and will remain in the same place, and the same length, no 
matter what data is inserted.  

Pictures 

Inserting pictures into your document is a simple task.   Before inserting a picture, go 
into the Advanced Section of Word Options in the Office button and make sure the box 
―Show picture placeholders‖ is unchecked. Otherwise, Word will show an empty box in 
your document instead of the picture itself. 
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Inserting a picture in an IF statement 

You can insert a picture into an IF statement.  To do this, place the cursor in the desired 
location within the IF statement.   For instance, perhaps you have 2 agency logos and 
you want to use logo #1 for Agency #1 and logo #2 for Agency #2. Create an IF 
statement that tests if the Agency datafield is equal to 1; between the double quotes of 
the "if true" section, insert logo#1, and between the double quotes of the "if false" 
section insert logo#2.  
 

 
 
Format the pictures to be the size and location you want. In the formletter or proposal 
template, the pictures may not appear in the desired location.  Merging the template at 
the client level will reveal the true location of the picture.  You may need to reposition 
your picture in the template based on how it appears when it is merged at the client 
level.   

Math Functions in Tables 

Although not as powerful or as varied as Excel, there are some basic math functions 
available within tables in Word.   
 
Tables have cell references just like Excel EXCEPT you do not see the Column and 
Row labels.  In the example shown below, the cell reference is displayed in each cell: 
 

A1 B1 C1 D1 

A2 B2 C2 D2 

A3 B3 C3 D3 

 

In the IF statement, put your Agency 

Two logo in the “If False” section 

In the IF statement, put your Agency 

One logo in the “If True” section 
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Place your cursor in the cell where you want the formula results to be displayed.  The 
table tabs on the ribbon will activate.  Click on the Layout tab, then click on the formula 
button. 
 

 
 
If there are numbers displayed in the cells above or to the left of the selected cell, an 
automated formula (=Sum(Above)) or (=Sum(Left)) will be shown in the formula field. 
 
If neither of these is the desired formula, delete the automated formula leaving just the 
equal (=) sign in the brackets. Or of course you can enter the field manually as 
described earlier, with Ctrl-F9 and typing inside the brackets. Then enter the formula 
you need based on the available functions.  Examples of the available functions are 
shown below. 
 
Add – "+" 
Add a number to a cell =(A1)+3 
Add two adjacent cells =SUM (A1:A2) or =(A1+A2) 
Add two non-adjacent cells =(A1+A3) or =(A1)+(A3) 
Add a range of cells =SUM(B1:B3) 
Add an entire column =SUM(D:D) 
  
Subtract – "-" 
Subtract a number from a cell =(A1)-1 
Subtract two cells =(A3-B2) 
 
Multiply – "*" 
Multiply a cell by a number =(A1)*3 
Multiply two adjacent cells =PRODUCT(A1:A2) 
Multiply two non-adjacent cells =(B1*B3) or =PRODUCT(B1)*(B3) 
 
Divide – "/" 
Divide a cell by a number =(C2)/3 
Divide two cells =(C2)/(A1) 
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If you are using the Formula button the Layout tab, select 
the function from the Paste Function box.  For instance, 
to add numbers, choose SUM from the Paste Function 
drop down box. Or you can manually type these functions 
into the formula field. 
 
To reference cells in formulas, use a comma to separate 
references to individual cells (i.e., (=SUM(A1,B3) and a 
colon to separate the first and last cells in a designated 
range (i.e., (=SUM(A1:D1).  You can reference an entire 
row or column in a calculation in the following ways: 
 

 Use a range that includes only the letter or number 
that represents it — for example, 1:1 to reference 
the first row in the table. This designation allows the calculation to automatically 
include all the cells in the row if you decide to add other cells later.  
 

 Use a range that includes the specific cells — for example, a1:a3 to reference a 
column with three rows. This designation allows the calculation to include only 
those particular cells. If you add other cells later and you want the calculation to 
include them, you need to edit the calculation.  

 
You can format the results of your formula by selecting the format from the available 
options in the Number format box. For example, to display the numbers as a decimal 
percentage, click 0.00%.  
 
Notes:  
Word inserts the result of the calculation as a field in the cell you selected and does not 
automatically update the formula results if there are changes to the referenced cells. 
You can update the calculation by clicking once on the field (or selecting the entire 
table) and then pressing F9. Also, once you build the proposal at the client level, all the 
formulas are replaced by the actual results; if you change the numbers in the cells the 
total will need to be updated manually. 
 
If you see codes between braces instead of the actual sum (for example, {=SUM(LEFT)} 
not the number result you wanted), press SHIFT+F9 or ALT+F9 to switch to the number 
result. 
 
See the Appendix for a couple of samples showing how you can use formulas 
containing math functions. 
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Styles 

Styles define the appearance of various text elements of a document, such as 
headings, captions, and body text.  When a style is applied to any portion of a 
document, multiple character or paragraph format options will be applied in a single 
operation.  When a change to the formatting of all of the text of a particular element 
needs to be made, simply change the style that's applied to that element.  Styles make 
formatting your document easier. Additionally, they serve as the source information for 
outlines and tables of contents. 
 
The template asword.dot includes styles designed by Applied for formletter and 
proposal templates.  A key element in setting your agency apart from your competition 
is the creation of styles UNIQUE to your agency. 
 
Styles can also cause problems in formletters and proposals, if you use the default style 
names that are built in to Word. This is because those style names exist on every 
workstation in your office – but they do not necessarily all have exactly the same 
features. For instance the Normal style on one workstation might be Times New 
Roman 12, and on another workstation Arial 10. When you run a formletter or proposal 
on a workstation, it overrides the style definitions in the document with those on the 
workstation, if it finds styles with the same name. So we strongly recommend that you 
create unique style names for your agency’s documents, and use those exclusively.  
 
One of the first steps in creating those unique styles is determining the formatting to 
include in the various styles you want for your agency’s proposal templates. You will 
need several styles, for page headers, subsection headers, paragraph (or body) text, 
and so on. You may want to define a style for table column headings for instance. 
 
When you are determining formatting, here are some of the elements you will need to 
consider when creating each unique style for your agency. 

 font type  

 font size  

 bold 

 italicize 

 underline   

 justification:  left, right, center or full 

 paragraph spacing 

 borders and shading 

 color 
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Creating Your Agency’s Unique Styles 

The steps below will help you to create your own unique styles. 

 On the Home tab, select the dialogue box icon in the bottom left corner of the 
Styles group.  
 

 
 
 

 Click on the NEW Style button at the bottom of the Styles dialogue box.   You 
can use text that has already been formatted as the basis for a style.  To do this, 
highlight the desired text before creating a new style.  
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Address the following areas in the Create New Style from Formatting box:  
o Name – Type in a name 

for the style you are 
about to create – this 
name should be unique 
(e.g., initials of your 
agency & then type of 
style –  
BHB PropNormal). 

o Style Type – Pick the 
appropriate type from 
the dropdown list – 
Paragraph is the most 
commonly used. 

o Style Based On – It is 
recommended that you 
select "No Style" from 
the top of the list. If you 
base your agency style 
on an existing style that 
may have different 
properties on the 
various workstations in your office, you run the risk of having 
inconsistencies in the proposals in your office, depending on what 
workstation they are created on.  

o Style For Following Paragraph – All existing styles are listed – you can 
select the style you want for the text that will follow in the next paragraph. 
(it can be the same style as the one you are creating.) 

o Formatting – In this area of the dialogue box, you can select text 
formatting options such as font and size.  Note:  Formatting options are 
available under the Format button in the lower left hand corner as well.  

o Click the ―Add to Quick Style List‖ if you want to see this particular style on 
the Home tab in the Styles group. 

o By checking the Automatically Update check box, Word will automatically 
redefine the style you selected whenever you apply manual formatting to 
any paragraph with this style.   This option is OFF by default and is 
recommended for experienced style users only.  This option is only 
available for paragraph styles, and is not recommended for the Normal 
style. 

o Verify the ―New Documents Based on this Template‖ radio button is 
selected. 

o Once this dialogue box has been completed to your satisfaction, click OK. 

 This style has now been added to the normal.dotm template. 

 Repeat the above process for each style that will become a part of your 
customized proposal templates. 

 Close Word, there is no need to save changes. 
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Adding Agency Styles to Proposal Templates 

To copy the unique styles you created for your agency into proposal templates, you will 
need to use the Style Organizer.  The organizer feature is not available from any of the 
ribbon tabs.  When working with customizing proposal templates, you should add this 
command to the Quick Access Toolbar.   
 
Here are the steps for adding the Style Organizer command to the Quick Access 
toolbar. 

 Right-click anywhere on the Quick Access Toolbar. 

 Left click on Customize Quick Access Toolbar. 

 In the ―Choose Commands From:‖ field, click the drop down arrow and select ―All 
Commands‖. 

 In the available fields tab, scroll down and locate Organizer and click the ―Add‖ 
button to move that command into the list of selected commands to be displayed 
on the Quick Access Toolbar. 

 Click OK and exit Word. 
 
To add the Styles to your proposal documents: 

 Opent the desired proposal template to which you need to add your agency’s 
styles. 

 Click Revise. 

 Click Edit. 

 Click the ―Organizer‖ icon  
on the Quick Access Toolbar. 

 Hold down the CTRL key and 
select the styles from the ―In 
Normal‖ list on the right and 
then click on the Copy button 
to move these styles to the 
active proposal template. 

 Click Close. 
 
Your agency’s defined styles now reside in the individual proposal template.  If you are 
utilizing a copy of an existing TAM template, select text and apply styles as needed.  If 
you are creating a NEW proposal template, enter text and apply styles as needed. 
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Appendix – Math Samples 

Here is a sample of the coding for creating a total of the values in an equipment 
schedule. 

 The total is outside the replicate commands. You only want one total! 

 The formula uses the SUM function referencing the fourth column (column d) in 
the table. By using this method instead of SUM(ABOVE), the total will be correct 
even if there are blank limit entries. SUM(ABOVE) stops calculating if it 
encounters a blank cell. 

 Apply the same formatting to the total formula as you apply to the individual 
items. 

 
 
And here’s the result on the client’s proposal: 
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Here we use the sum and multiply functions to multiply the results of ASK variables by 
various factors to obtain the applicable tax and fees, then add those items together to 
get the total amount due. 
 
Formulas Look Like This: 

 
End Result is this: 

 


